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This guide explains how to customize and deploy SMART Meeting Pro™ software.

This guide is intended for IT administrators and others experienced with customizing, deploying and
administeringWindows® software in a networked environment. To use this guide, youmust

l Know IT terminology such as “registry” and “domain controller”

l Know how to complete basic administrative tasks inWindows operating systems such as
modifying the registry

l Have administrative privileges and access to servers

l Have Internet access

I M P OR TA N T

Youmust run the commands documented in this guide in anAdministrator Command Prompt
window. To open anAdministrator Command Prompt window, right-click theCommand Prompt
icon, and then select Run as Administrator.

N OTE S

l As an alternative to customizing and deploying SMART Meeting Pro software as documented
in this guide, you can install the software by downloading and using the installation wizard.
The installation wizard includes Help that explains how to configure the software.
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l If you want to customize and deploy SMART Meeting Pro connector for Microsoft® Lync®
and Remote Ink by SMART, see Installing and configuring SMARTMeeting Pro connector for
Lync on page 53.

Installation overview

To install SMART Meeting Pro software

1. Ensure your computers meet theminimum software and hardware requirements (seeComputer
requirements below).

2. Download the required installation packages (see Installation packages and supporting files on
the next page).

3. Customize the SMART Meeting Pro software installation packages (seeUsing
SMART Install Manager on page 6 andUsing third-party tools on page 13).

4. Deploy the installation packages (seeDeploying the software on page 15).

5. Configure SMART Meeting Pro software after deployment if required (seeConfiguring
SMART Meeting Pro software on page 21).

Computer requirements
Before you install SMART Meeting Pro software, ensure your computers meet theminimum
requirements defined in this section.

For one- or two-display systems
l Windows 7 orWindows 8 operating systems

l 2GHz dual-core processor or faster (quad-core recommended)

l 2GB of RAM (4GB recommended)

l 1GB of free hard disk space for minimum installation (additional free space required during
installation)

l Microsoft .NET Framework 4 Full (not Client)

l Microsoft Visual Studio® Tools for Office
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For three- to eight-display systems
l Windows 7 orWindows 8 operating systems

l 2GHz dual-core processor or faster (quad-core recommended)

l 4GB of RAM

l 1GB of free hard disk space for minimum installation (additional free space required during
installation)

l Microsoft .NET Framework 4 Full (not Client)

l Microsoft Visual Studio Tools for Office

For nine- to 16-display systems
l Windows 7 orWindows 8 (64-bit) operating systems

l 3GHz dual-core processor or faster (quad-core recommended)

l 8GB of RAM ormore

l 1GB of free hard disk space for minimum installation (additional free space required during
installation)

l Microsoft .NET Framework 4 Full (not Client)

l Microsoft Visual Studio Tools for Office

Installation packages and supporting files
The following installation packages (also known as MSI files) and supporting files are required to
install and configure SMART Meeting Pro software.

Save the packages in a location on your network that’s accessible to all the computers on which you
plan to install the software.

Third-party installation packages
The following third-party installation packages are contained in the SMART Meeting Pro software .zip
file available from smarttech.com/administratordownloads. The installation packages are located in
folders in the .zip file.

T I P

You can also download these third-party installation packages frommicrosoft.com/downloads.

http://www.smarttech.com/administratordownloads
http://www.microsoft.com/downloads
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Installation package File name

Microsoft .NET Framework 4
(Standalone Installer)

dotNetFx40_Full_x86_x64.exe

Microsoft Visual Studio Tools for Office
for 32-bit computers

vstor40_x86.exe

Microsoft Visual Studio Tools for Office
for 64-bit computers

vstor40_x64.exe

N OTE

You can run the dotNetFx40_Full_x86_x64.exe file to install all requiredMicrosoft .NET
Framework prerequisites and theMicrosoft .NET Framework 4 Full files. However, SMART
recommends that you download the latest version of theMicrosoft .NET Framework files from the
Microsoft website. For information on deploying theMicrosoft .NET Framework, refer to the .NET
Framework Deployment Guide for Administrators on theMSDN® website
(msdn.microsoft.com/en-us/library/ee390831.aspx).

SMART software installation packages
Download the .zip files containing these installation packages from
smarttech.com/administratordownloads.

Installation package File name

SMART Product Drivers SMART Product Drivers Installer.msi

SMART Meeting Pro software SMART Meeting Pro.msi

Language files
If you plan to deploy the installation packages in a language other than English (U.S.), ensure the
correspondingMST file for the language is in the same folder as theMSI file (see Installation
language files and codes on page 49).

Similarly, if you want users to be able to view and use the software in a language other than English,
youmust download and install the appropriate language pack (see Language packs on page 50).

These language packs are located in the Language folder in theSupport folder of the .zip file.

http://msdn.microsoft.com/en-us/library/ee390831.aspx
http://www.smarttech.com/administratordownloads
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Chapter 2: Customizing installation
packages
Using SMART Install Manager 5

Installing SMART Install Manager 5
Using SMART Install Manager 6

Opening an installation package 6
Saving your changes 7
Publishing your changes as anMST file 7

Customizing the SMART Meeting Pro installation package 8
Customizing the SMART Product Drivers installation package 11

Using third-party tools 13

You can customize installation packages using SMART Install Manager.

OR

You can customize installation packages using third-party tools andWindows Installer properties.

Using SMART Install Manager
SMART Install Manager enables you to customize SMART software installation packages (also
known as MSI files) by publishingMST files. You can then deploy theMSI andMST files to
computers using third-party imaging or remotemanagement software.

Installing SMART Install Manager
Download and install SMART Install Manager from the SMART Support website.

To install SMART Install Manager

1. Go to smarttech.com/administratordownloads.

2. Scroll toSMARTMeeting Pro software, click Choose a version, and then select
SMART Meeting Pro software > 4 for Windows.

http://www.smarttech.com/administratordownloads
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3. Click Download SMART Install Manager, and then click Download.

4. Save the Install Manager.exe file to your computer.

5. Double-click the Install Manager.exe file.

The SMART Install Manager installation wizard appears.

6. Follow the on-screen instructions.

Using SMART Install Manager
After you install SMART Install Manager, shortcuts to the software appear on the desktop and in the
Start menu (Windows 7 operating system) or theApps screen (Windows 8 operating system).

With SMART Install Manager, you can do the following:

l Open and customize an installation package.

l Save your changes to the installation package as an XML file.

l Publish your changes to the installation packages as anMST file.

Opening an installation package
To customize an installation package, drag its MSI file into the SMART Install Manager window.

Alternatively, you can search for installation packages on your computer by clicking .

N OTE

All installation packages you’ve previously opened in SMART Install Manager appear in the
Unmodified Packages tab.
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After you open an installation package, a set of pages for that installation package appears in
SMART Install Manager. Customize the installation package using the controls on these pages.

Saving your changes
After you customize an installation package, save your changes as an XML file by selecting File >
Save As. When you next start SMART Install Manager, load the XML file by selecting File > Open,
or by opening theMSI file and then selecting File > Import.

Publishing your changes as an MST file
The final step in using SMART Install Manager to customize an installation package is to publish your
changes as anMST file. To do this, select File > Publish, and then use the dialog box to define a
location for and create theMST file.

T I P

If you use an older MST file created with an earlier version of theMSI file, it might not work properly.
Use the current MSI file to create your MST file. Publish theMST file in the same location as the
MSI file.
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Customizing the SMART Meeting Pro installation package
To customize the SMART Meeting Pro installation package, open theSMART Meeting Pro.msi file
in SMART Install Manager (seeOpening an installation package on page 6), and then set the controls
on each page.

Control Procedure Notes

Installation Options

Installation directory Type the path to your preferred folder for
SMART Meeting Pro software.

If you don’t specify a folder,Windows Installer
installsSMART Meeting Pro software in
[Program files (x86) folder]\
SMART Technologies\
SMART Meeting Pro.

SMART Meeting Pro Type your 25-character product key for
SMART Meeting Pro software.

When the software deploys, the product key
activates the software.

SMART Meeting Pro
connector for Lync

Type your 25-character product key for
SMART Meeting Pro connector for Lync in the
appropriate product keybox to enable the Lync
collaboration option.

You can type the product keywith or without
hyphens.
When you type a volume product key, the
software activateswhen you deploy it to your
network computers.

Activate SMART
software during
installation

Select to activate SMART Meeting Pro
software automatically during installation rather
thanmanually after installation.

Shortcuts

Install Desktop
shortcut

Select to create shortcuts to
SMART Meeting Pro software on the desktop.

Launch
SMART Meeting Pro
at Startup

Select to start SMART Meeting Pro software
automaticallywhen the user logson.

Microsoft Exchange and E-mail Server Settings

Enable integration
with Microsoft
Exchange

Select to enableMicrosoft Exchange
integration with SMART Meeting Pro software.

For more information onMicrosoft Exchange
integration, seeConfiguringMicrosoft
Exchange settings on page 25.
Youmust add the room resource’s unique e-
mail addressafter installation (seeAdding a
unique e-mail address to each computer after
installation on page 22).
Users can access their Microsoft Outlook®
meeting details and e-mailWhiteboard files to
themselvesor to other users in
SMART Meeting Pro software.

Auto start scheduled
meeting at logon

Select to automatically start scheduled
meetingseach time a user starts a new session.

Auto bookad hoc
meeting at logon

Select to automatically bookand start an
unscheduledmeeting each time a user starts a
new session if the room resource is available.
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Control Procedure Notes

Auto reset room after
meeting end time

Select to automatically reset the room 5
minutesafter ameeting’s scheduled end time.
Use the drop-downmenu to change the delay
time.

Auto insert agenda at
meeting start

Select to automatically insert meeting details
into the drawing area each time a scheduled
meeting starts.

Enable SMTPe-mail
configuration

Select to configure SMTPe-mail settingsor the
computer’s default e-mail client.

If you don’t enableMicrosoft Exchange
integration settings, you can still configure
SMTPe-mail settings. Users are unable to
access their Outlookmeeting details, but they
can still e-mailWhiteboard files.

Sender e-mail
address

Type the sender e-mail address for the
SMART Meeting Pro software installation.

Users can e-mailWhiteboard files to
themselvesor to other users in
SMART Meeting Pro software. The software
uses this e-mail address in theSender field.
If the computer doesn’t have an e-mail client
installed, enter a do not reply value. This
indicates tomail recipients that they can’t reply
to e-mails they receive.

SMTP server name Type the name of the SMTP server. Users can e-mailWhiteboard files to
themselvesor to other users in
SMART Meeting Pro software. The software
uses this e-mail server to send the file.

Use the computer’s
default e-mail client to
send e-mailmessages

Select to use the computer’s default e-mail
client to send e-mailmessages.

The default e-mail client must be properly
configured for e-mail to be sent.

SMART Meeting Pro Collaboration Information

Disable remote
collaboration

Select to disable remote collaboration. You’re unable to change the collaboration
option after installation.

Enable Lync
integration

Select to enable Lync integration for
SMART Meeting Pro software remote
collaboration.

You’re unable to change the collaboration
option after installation.
The computer hosting SMART Meeting Pro
softwaremust have Lync client software
installed and network access to Lync2010
Server. To use the featuresof Remote Inkby
SMART, Remote Ink client and Remote Ink
service softwaremust also be deployed.
For more information, see Installing and
configuring SMART Meeting Pro connector for
Lync on page 53.

Enable Bridgit
integration

Select to enable Bridgit® integration for
SMART Meeting Pro software remote
collaboration.

You’re unable to change the collaboration
option after installation.
If no server name is provided, Bridgit software
integration is disabled.
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Control Procedure Notes

Bridgit Server Type the name of the Bridgit server (for
example, bridgit.example.com).

The Bridgit server enables the
SMART Meeting Pro software installation to
connect to other SMART Meeting Pro software
installations.

Accesspassword Type the accesspassword for the Bridgit
server.

Creation password Type the creation password for the Bridgit
server.

Automatically share
primary screen

Select to share themain screen each time a
user starts a new session.

Showmeeting
password on
collaboration bar

Select to show themeeting password in text on
the Bridgit Collaboration Bar.

Additional Configuration

Default whiteboard
style

SelectUnbound Whiteboard to present
pages in unboundWhiteboard style.
OR
SelectClassic Whiteboard to present pages
in classicWhiteboard style.

In unboundWhiteboard style, pageshave no
defined boundaries, and the page area can be
significantly larger than the viewable area. This
is beneficialwhen userswant to use
Whiteboardmode for brainstorming or to zoom
in on specific details in large, detailedmaps,
diagramsor other images.
In classicWhiteboard style, pageshave defined
boundaries, and the page area is usually the
same asor slightly larger than the viewable
area. This is beneficialwhen userswant to
present content to others inWhiteboardmode
and want all content to be visible at the same
time in the viewable area.
SMART recommends that you select unbound
Whiteboard style.

Default mode SelectDesktop to enable SMART Meeting Pro
software to open in Desktopmode.
OR
SelectWhiteboard to enable
SMART Meeting Pro software to open in
Whiteboardmode.
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Control Procedure Notes

Default file save
format

Select the default file format that
SMART Meeting Pro software uses to save
whiteboard pages. Select from the following
formats:
l .fcw
l .pdf
l .ppt (.pptx)
l .notebook

If you select the unboundWhiteboard style, do
not select .notebookas the default file format.
Users are unable to save unboundWhiteboard
files to .notebook format.
Files saved in .pdf format can’t be opened again
in SMART Meeting Pro software.
Files saved in .ppt or .pptx format can be
opened in SMART Meeting Pro software but
have reduced functionality.
Users are still able to select a different file
format when they save whiteboard pages.

Ink type SelectCalligraphic to use calligraphic ink,
which smoothes your writing strokesand
improves the readability of your notes.
OR
SelectRegular to use regular ink.

SMART recommends that you select
calligraphic ink.

Administrator
password

Type a password that usersmust enter to
modify the SMART Meeting Pro software
settings.

If you leave this boxblank, no password will be
required to change SMART Meeting Pro
software settings.

Gallery Location

SaveGallery content
added byuser in

Type the path to your preferred folder for
added content. If you don’t specify a folder,
added content is stored in the following default
folder: [Public documents folder]\
SMART Technologies\Gallery\
Added Content.

TheAdded Content folder is a location on the
local computer where user-created content is
stored.

AdditionalGallery
Folder

Type the path to your preferred folder to add
gallery folders.

Customizing the SMART Product Drivers installation package
To customize the SMART Product Drivers installation package, open theSMART Product Drivers
Installer.msi file in SMART Install Manager (seeOpening an installation package on page 6), and
then set the controls on each page.

Control Procedure Notes

Installation Options

Installation directory Type the path to your preferred folder for
SMART Product Drivers.

If you don’t specify a folder,Windows Installer
installsSMART Product Drivers in
[Program files (x86) folder]\
SMART Technologies\
SMART Product Drivers.

Language Selection

Select the language
packs you want to
install

Select the language packs you want to install. Some SMART software doesn’t support all
listed languages.
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Control Procedure Notes

SMART Product Update

Install SMART
Product Update in Full
mode

Select to install SMART Product Update (SPU)
in Fullmode.

In Fullmode, users can view the installed
versionsof SMART software aswell as their
product keys, and download and install
updates.

Install SMART
Product Update in
Dashboardmode

Select to install SPU in Dashboardmode. In Dashboardmode, users can view only the
installed versionsof SMART software and their
product keys.

Do not install SMART
Product Update

Select to not install SPU.

Check for updates Type the number of days (1 to 60) between
SPU checks.

This option is available only if you install SPU in
Fullmode.
Bydefault, SPU checks for product updates
every 30 days.

Notify users about
SMART product
updates

Select to notify users of available SMART
product updates through theWindows
notification area.

This option is available only if you install SPU in
Fullmode.

Customer Experience

Enable the Customer
Experience Program
on all devices

Select to automatically enable the Customer
Experience Program for all users.

Users can disable the Customer Experience
Program through theHelp menu.

Disable the Customer
Experience Program
on all devices

Select to automatically disable the Customer
Experience Program for all users.

Users can’t enable the Customer Experience
Program through theHelp menu.

Optional Settings

Enable Tablet PC
Support

Select to use Tablet PC functionalitywith your
SMART interactive displaywithout having to
connect a Tablet PC.

Enabling Tablet PC support is applicable to
Windows7 operating system only. It hasno
effect on other operating systems.

Start SMART Menu
Icon at logon

Select to display the SMART Board® icon in the
notification area when the computer starts.

Start SMART Inkat
logon

Select to start SMART Ink™when the user logs
on.

Make SMART Ink
Viewer the default
PDF viewer

Select to make SMART InkViewer to the
default PDF viewer.

Start Simple Network
Management Protocol
(SNMP) Agent

Select to start the SNMPagent.

Register unsigned
drivers

Select to enable the registration of unsigned
third-party drivers.

If you enable the registration of unsigned
third-party drivers, the installation process could
askusers if they trust themakers of the drivers
during installation. This can cause issues if you
deploy the installation in Silent mode.
Therefore, it’s best to disable the registration of
third-party drivers if you deploy the installation in
Silent mode.
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Using third-party tools
You can customize SMART software installation packages by creatingMST files using a third-party
tool, such as Orca database editor, and theWindows Installer properties (seeWindows Installer
properties and parameters on page 41).
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Chapter 3: Deploying the software
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Using third-party imaging or remotemanagement software 19

After downloading the installation packages (see Installation packages and supporting files on page
3) and customizing them (seeCustomizing installation packages on page 5), deploy them in the
following order:

Order Installation package

1 Microsoft .NET Framework 4 Extended Profile and Client Profile (if not installed)

2 Microsoft Visual Studio Tools for Office (if not installed)

3 SMART Product Drivers

4 SMART Meeting Pro software

You can deploy installation packages using the command line interface.

OR

You can deploy installation packages using third-party imaging or remotemanagement software.

N OTE S

l Youmight need tomanually activate SMART Meeting Pro software after you deploy it (see
Activating SMART Meeting Pro software after installation on page 21).

l Youmight need to orient your interactive whiteboard again after installing SMART Meeting Pro
software on amultiple display system (seeOrienting your SMART interactive product after
installation on page 23).
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Using the command line interface
Using the command line interface, you can deploy installation packages inmany ways, including
running commands from the Command Prompt window and including commands in batch script files.

I M P OR TA N T

If you want to install language packs, youmust do so when you first deploy the software. If you
want to install a language pack after you first deploy the software, youmust do so using the
language pack’s individual MSI file.

Installing prerequisite third-party software
Use the following procedures to install Microsoft .NET Framework 4 Full files and
Microsoft Visual Studio Tools for Office.

N OTE S

l Formore information on theMicrosoft .NET Framework, refer to the .NET Framework
Deployment Guide for Administrators on theMSDN website
(msdn.microsoft.com/en-us/library/ee390831.aspx).

l Extended Profile and Client Profile installation packages are part of Microsoft .NET
Framework 4 (Standalone Installer) software.

l Formore information on deployingMicrosoft Visual Studio Tools for Office, refer to theHow to:
Install the Visual Studio Tools for Office Runtime Redistributable on theMSDN website
(msdn.microsoft.com/en-us/library/ms178739.aspx).

To install the Microsoft .NET Framework 4 Full files

Run the following command to install the files in UI mode:

[Path]\dotNetFx40_Full_x86_x64.exe /passive /showfinalerror

OR

Run the following command to install the files in silent mode:

[Path]\dotNetFx40_Full_x86_x64.exe /q

Where [Path] is the path to the dotNetFx40_Full_x86_x64.exe file.

http://msdn.microsoft.com/en-us/library/ee390831.aspx
http://msdn.microsoft.com/en-us/library/ms178739.aspx
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To install Microsoft Visual Studio Tools for Office for 32-bit computers

Run the following command:

[Path]\vstor40_x86.exe /q

Where [Path] is the path to the vstor40_x86.exe file.

To install Microsoft Visual Studio Tools for Office for 64-bit computers

Run the following command:

[Path]\vstor40_x64.exe /q

Where [Path] is the path to the vstor40_x86.exe file.

Installing SMART Product Drivers
Use the following procedures to install SMART Product Drivers.

N OTE S

l Language packs are included in the SMART Product Drivers 11 (and later) .zip files (see
SMART Product Drivers installation package on page 45).

l For known installation issues, refer to theWindows operating systems section of the
SMART Product Drivers release notes available from smarttech.com/support.

To install SMART Product Drivers

Run the following command if you created anMST file to customize the installation package:

msiexec /i "[Path]\SMART Product Drivers Installer.msi"

TRANSFORMS="[MST file]" [Parameter]

OR

Run the following command if you didn’t create anMST file to customize the installation
package:

msiexec /i "[Path]\SMART Product Drivers Installer.msi"

[Properties] [Parameter]

Where

o [Path] is the path to theSMART Product Drivers Installer.msi file andMST file.

o [MST file] is the name of theMST file.

http://smarttech.com/support
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o [Properties] is a set of properties you can include to customize the installation (see
SMART Product Drivers installation package on page 45).

o [Parameter] is the installation parameter (seeParameters on page 47).

Installing SMART Meeting Pro software
Use the following procedure to install SMART Meeting Pro software.

To install SMART Meeting Pro software

Run the following command if you created anMST file to customize the installation package:

msiexec /i "[Path]\SMART Meeting Pro.msi" TRANSFORMS="[MST file]"

[Parameter]

OR

Run the following command if you didn’t create anMST file to customize the installation
package:

msiexec /i "[Path]\SMART Meeting Pro.msi" [Properties] [Parameter]

Where

o [Path] is the path to theSMART Meeting Pro.msi file andMST file.

o [MST file] is the name of theMST file.

o [Properties] is a set of properties you can include to customize the installation (see
SMART Meeting Pro installation package on page 41).

o [Parameter] is the installation parameter (seeParameters on page 47).
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Using third-party imaging or remote management
software
The following procedure shows how to deploy SMART software using Group Policy-based
deployment software. For information on deploying SMART software using your organization’s
third-party imaging or remotemanagement software, see the software’s documentation.

N OTE

This proceduremay vary depending on your version of Windows operating system and your system
preferences.

To deploy an installation package

1. Copy theMSI file and theMST file to \\[Domain Controller]\NETLOGON, where
[Domain Controller] is your domain controller.

2. Open Control Panel, double-click Administrative Tools, and then double-click
Active Directory Users and Computers.

TheActive Directory Users and Computers window appears.

3. Right-click your domain, and then select Properties.

TheProperties dialog box appears.

4. Click theGroup Policy tab, and then click Edit.

TheGroup Policy Object Editor dialog box appears.

5. Browse toComputer Configuration\Software Settings.

6. Right-click Software Installation, select New > Package, and then browse to and select the
MSI file from step 1.

7. In theDeploy Software section, click Advanced, and then click OK.

8. Click theModifications tab, click Add, and then browse to and select theMST file from step 1.

9. Click OK to apply theMST file to theMSI file.

10. Close all open windows and dialog boxes.

N OTE

The time it takes to deploy the software depends on the size of your network.
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This chapter provides information on using the following procedures to configure SMART Meeting Pro
software after installation.

l Activating SMART Meeting Pro software after installation

l Adding a unique e-mail address to each computer

l Orienting your SMART interactive product

l Configuring 4K UHD displays

Activating SMART Meeting Pro software after
installation
There are two situations in which the software doesn’t activate completely:

l Imaging a computer: For the software to activate properly, each computer you install it on
must have a unique installation ID. If you use a computer image or clone a hard drive to set up
multiple computers, they all have the same installation ID as the original computer, which can
cause an activation error.

l Protecting software for computer configurations: If you use system recovery or protection
software, you should activate the software before you lock or freeze the computer for your users.
However, if you can’t, youmust activate the software afterward.



C H A P T E R 4

Configuring SMART Meeting Pro software

22 smarttech.com/kb/170518

To activate SMART Meeting Pro software after installation

Run the following command:

"C:\Program Files\Common Files\SMART Technologies\

SMART Product Update\activationwizard.exe" --puid meeting_pro

--m=[Value] --v=3 --a [Optional flags] --pk [Product key]

Where

o [Value] is 4 to run the activation wizard in unattendedmode.

OR

[Value] is 6 to run the activation wizard in user interfacemode.

o [Optional flags] are optional flags you can include to configure the activation wizard.

Flag Purpose

--monitor=[Number] Specify themonitor to display the activation wizard.

--proxy=[Host:Port] Specify the proxy host and port number to use for
activation.

--proxyuser=[User] Specify the proxy user name to use for activation.

--proxypassword=[Password] Specify the proxy password to use for activation.

--locale=[Code] Display the activation wizard user interface in a
specific language, where [Code] is your language
code (see Installation language files and codes on
page 49).

o [Product key] is the software product key.

Adding a unique e-mail address to each
computer after installation
For proper integration of Microsoft Exchange, each computer you install SMART Meeting Pro
software onmust have a unique room resource e-mail added in the registry entry. This e-mail address
identifies the room within your Microsoft Exchange Server. This enables users to reserve a room
resource by booking the room in the sameway they book other meeting participants.

Complete the following procedure to add a unique room resource e-mail address to the registry entry
of each computer.
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C A U T I ON

Use caution when you open theWindows registry editor. If you incorrectly modify theWindows
registry, you can damage your computer’s operating system. Back up your registry before
performing the following procedures.

T I P

For information on configuring amass deployment of unique room resource e-mail addresses, see
the online Help systems for your network administration tools.

To add an e-mail address to the registry entry after installation

1. Open the Registry Editor.

2. Use the following table to locate the appropriate key for your operating system.

Operating system Folder location:

32-bit HKEY_LOCAL_MACHINE\Software\SMART
Technologies\SMARTMeeting Pro\Version 4.0\MSExchange

64-bit HKEY_LOCAL_MACHINE\Software\Wow6432Node\SMART
Technologies\SMARTMeeting Pro\Version 4.0\MSExchange

3. Right-click MeetingRoomEmail, and then selectModify.

4. Type the room resource computer’s unique e-mail address in theValue data box, and then click
OK.

5. Close theRegistry Editor window.

6. Restart SMART Meeting Pro software.

Orienting your SMART interactive product after
installation
If after you install SMART Meeting Pro software on amultiple display system your touch on one
screen registers on another, youmust orient your interactive product again.

Use the following procedure to orient your interactive product using SMART Settings.
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To orient multiple interactive products

1. Press theSMART Board icon in the notification area, and then select Orient.

N OTE S

o You can also access the orientation screen by pressing theOrient button on your
SMART interactive product. See your interactive product’s user’s guide for the location of
this button.

o If your computer isn’t currently connected to an interactive product, theSMART Board
icon is gray and includes an X in its lower-right corner .

o Sometimes, the orientation screen appears on your primary interactive product instead of
the interactive product you want to orient. If this happens press SPACEBAR until the
orientation screen appears on the interactive product you want to orient.

2. Touch the center of each target in the order indicated. The computer registers the point on the
interactive product where you remove your finger or pen tool from the surface.

The orientation procedure involves pressing 4, 9, 12 or 20 targets, depending on the orientation
level you select (see the SMART Meeting Pro software online Help for more information on
changing the orientation level of your interactive product).

Configuring 4K UHD displays
If you’re using SMART Meeting Pro software with a 4K UHD display, set the dots per inch (DPI) to
150. For more information, see the operating system’s Help.
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SMART Meeting Pro software can integrate with Microsoft Exchange to provide a seamless meeting
experience.

Users can schedulemeetings from their personal computers usingMicrosoft Outlook. When users
include a room resource in their invitations, they can access themeeting details from
SMART Meeting Pro software when they log into the room resource computer.

This chapter provides information on configuring theMicrosoft Exchange settings for
SMART Meeting Pro software using theSMARTMeeting Pro Settings dialog box.

Information is provided on the following configuration options:

l Accessing administrator settings

l Configuring settings

l Checking registry values assigned during the configuration process

l Configuring e-mail settings

N OTE

TheSMARTMeeting Pro Settings dialog box is available on each computer that hosts
SMART Meeting Pro software when the software is running.
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Accessing SMART Meeting Pro Settings
You can use theSMART Meeting Pro Settings dialog box to change various administrator settings.
You can also change your administrator password.

To access the SMART Meeting Pro Setting dialog box

1. Press theSMART Board icon in the notification area, and then select SMART Settings.

2. Press SMART Meeting Pro Settings.

TheSMART Meeting Pro Settings log on dialog box appears.

3. Type your administrator password, and then press OK.

N OTE

There is no password by default.

TheSMART Meeting Pro Settings dialog box appears.

To change the administrator password

1. Press theSMART Board icon in the notification area, and then select SMART Settings.

2. Press SMART Meeting Pro Settings.

TheSMART Meeting Pro Settings log on dialog box appears.

3. Press Change Password.

TheChange administrator password dialog box appears.

4. Type your current password and new password in the appropriate text boxes.

5. Press OK.

Changing Microsoft Exchange integration
settings
You can enableMicrosoft Exchange integration, change various automatic settings and configure a
service account.

To change Microsoft Exchange integration settings

1. Open theSMART Meeting Pro Settings dialog box (seeAccessing SMART Meeting Pro
Settings above).
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2. Press theMicrosoft Exchange tab.

3. Select theEnable Microsoft Exchange integration check box.

4. Change settings:

Control Procedure Notes (if any)

Room e-mail
address

Type your meeting room resource
e-mail address.

Auto start
scheduled
meeting at logon

Select the check box to enable
automatic starting of scheduled
meetings.

Auto book ad hoc
meeting at logon

Select the check box to enable
automatic creation of ad hoc
meetings.

Auto reset room
after meeting end
time

Select the check box to enable the
automatic end-meeting feature, and
then select the delay time before the
meeting automatically ends (in
minutes) from the drop-down list.

Auto insert
agenda at
meeting start

Select the check box to
automatically insert your meeting
details.

Use service
account instead
of logged on
user’s
credentials

Select the check box to use a
service account, and then type your
domain, user name and password in
the appropriate boxes.

In typical installations, you don’t use
a service account.

5. Optionally, press Server Settings, manually specify the URL of theMicrosoft Exchange and
Active Directory® servers that SMART Meeting Pro software authenticates against, and then
press OK.

N OTE

In typical installations, you don’t manually specify the URL of theMicrosoft Exchange and
Active Directory servers.

6. Press OK.
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Checking registry values
When you use theSMARTMeeting Pro Settings dialog box to configureMicrosoft Exchange, the
following registry keys are automatically configured:

l Meeting room e-mail

l Service account credentials

N OTE

If you didn’t select automatic detection of Microsoft Exchange Server and Active Directory server
options, theMicrosoft Exchange Server and Active Directory registry keys are automatically
configured.

Use the following procedure to ensure that the correct registry values were assigned during the
Microsoft Exchange configuration process.

C A U T I ON

Use caution when you open theWindows registry editor. If you incorrectly modify theWindows
registry, you can damage your computer’s operating system. Back up your registry before
performing the following procedures.

To check the registry key values

1. Log on to the computer hosting SMART Meeting Pro software as an administrator.

2. Open the Registry Editor.
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3. Use the following table to locate the appropriate key for your operating system.

Operating system Folder location:

32-bit HKEY_LOCAL_MACHINE\Software\SMART
Technologies\SMARTMeeting Pro\Version 4.0\MSExchange

64-bit HKEY_LOCAL_MACHINE\Software\Wow6432Node\SMART
Technologies\SMARTMeeting Pro\Version 4.0\MSExchange

4. Check the following registry key:

Name Description

MeetingRoomEmail SMART Meeting Pro software uses this registry key for the room
e-mail address. This key is required and should contain the e-mail
address of themeeting room in which SMART Meeting Pro
software is installed.

AuthUsername and
AuthPassword

If you selected theUse service account instead of logged-on
user’s credentials option in theMicrosoft Exchange tab, then
registry keys exist for the service account logon name and
password.

AuthADServer and
ConnURL

If you didn’t select automatic detection of Microsoft Exchange
Server and Active Directory server options duringMicrosoft
Exchange configuration, SMART Meeting Pro software requires
Active Directory andMicrosoft Exchange server addresses.

Changing e-mail settings
If you don’t enable integration with Microsoft Exchange (seeChangingMicrosoft Exchange
integration settings on page 26), you can use SMTP e-mail or the computer’s default e-mail client
instead.

N OTE

If you don’t enableMicrosoft Exchange integration, you’re unable to use themeeting notification
features of SMART Meeting Pro software. However, you can use SMTP e-mail to send your
meeting notes fromWhiteboardmode.

To change e-mail settings

1. Open theSMART Meeting Pro Settings dialog box (seeAccessing SMART Meeting Pro
Settings on page 26).

2. Press theE-mail tab.
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3. If you want to use SMTP e-mail, change settings:

Control Procedure Notes (if any)

E-mail address Type the sender e-mail address. The e-mail address you enter will
appear in the From field for any
outgoing e-mails. If the computer
doesn’t have an e-mail client
installed, don’t change the do not
reply default value. This indicates to
mail recipients that they can’t reply
to e-mails they receive.

SMTP server
name

Type your SMTP server location.

OR

If you want to use the computer’s default e-mail client, select theUse system e-mail check
box.

4. Press OK.

To restore default e-mail settings

1. Open theSMART Meeting Pro Settings dialog box (seeAccessing SMART Meeting Pro
Settings on page 26).

2. Press theE-mail tab.

3. Press Restore Defaults.

4. Press OK.
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Chapter 6: Updating the software
SMART periodically releases updates to its software. These updates add new features and resolve
issues.

Go to smarttech.com/software to download the latest installation package. SMART provides updates
in MSI file format in the installation package.

After you download an installation package and extract the update files, place the update files in a
location on your network that’s accessible to all the computers you plan to update.

I M P OR TA N T

You cannot roll back an update after installing it on your computers. Youmust remove the full
version of the software (seeRemoving the software on page 33), and then install the previous
version of the software.

The command line for running an update using aWindows Installer update installation package varies
depending on whether the update is major or minor.

N OTE

The SMART website indicates whether an update is major or minor.

To run a major software update using a Windows Installer update installation package

Run the following command:

msiexec /i "[Path]\[File].msi" [Parameter]

Where

o [Path] is the path to theMSI file.

o [File] is the name of theMSI file.

o [Parameter] is the installation parameter (seeParameters on page 47).

http://www.smarttech.com/software
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To run a minor software update using a Windows Installer update installation package

Run the following command:

msiexec /i "[Path]\[File].msi" REINSTALL=ALL REINSTALLMODE=vomus

[Parameter]

Where

o [Path] is the path to theMSI file.

o [File] is the name of theMSI file.

o [Parameter] is the installation parameter (seeParameters on page 47).
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SMART Uninstaller enables you to remove SMART software.

Using the user interface
You can remove SMART software from individual computers using the SMART Uninstaller user
interface.

To remove SMART software

1. InWindows 7 operating system, select Start > All Programs > SMART Technologies >
SMART Tools > SMART Uninstaller.

OR

InWindows 8 operating system, go to theApps screen and then scroll to and
press SMART Uninstaller.

2. Press Next.
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3. Select the check boxes of the SMART software and supporting packages that you want to
remove, and then press Next.

N OTE

SMART Uninstaller automatically removes any supporting packages that are no longer being
used. If you choose to remove all SMART software, SMART Uninstaller automatically
removes all supporting packages, including itself.

T I P S

o To select all software and supporting packages, press Select All.

o To clear the selection of all software and supporting packages, press Clear All.

4. Press Uninstall.

SMART Uninstaller removes the selected software and supporting packages.

5. Press Finish.

Using the command line interface
In addition to removing SMART software using the SMART Uninstaller user interface, you can
remove SMART software using the SMART Uninstaller command line interface. This enables you to
automate the removal of SMART software and remove SMART software remotely.

Recommended procedures
The following are recommended procedures for removing SMART software using the SMART
Uninstaller command line interface.

N OTE

SMART recommends that you copy SMART Uninstaller to a temporary location before running
command lines and prefix command lines with start /wait.

To remove all SMART software

1. Copy SMART Uninstaller to a temporary location by running one of the following commands:

o For 32-bit operating systems:

copy "%CommonProgramFiles%\SMART Technologies\

SMART Uninstaller.exe" "%TEMP%"
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o For 64-bit operating systems:

copy "%CommonProgramFiles(x86)%\SMART Technologies\

SMART Uninstaller.exe" "%TEMP%"

2. Remove all software by running the following command:

start /wait "SMART Uninstaller" "%TEMP%\SMART Uninstaller.exe"

--noui --uninstall-all --uilevel none

3. Delete the copy of SMART Uninstaller in the temporary location by running the following
command:

del "%TEMP%"\SMART Uninstaller.exe"

To remove select SMART software by product name

1. Copy SMART Uninstaller to a temporary location by running one of the following commands:

o For 32-bit operating systems:

copy "%CommonProgramFiles%\SMART Technologies\

SMART Uninstaller.exe" "%TEMP%"

o For 64-bit operating systems:

copy "%CommonProgramFiles(x86)%\SMART Technologies\

SMART Uninstaller.exe" "%TEMP%"

2. Remove select software by running the following command:

start /wait "SMART Uninstaller" "%TEMP%\SMART Uninstaller.exe"

--noui --uninstall "[Product names]" --uilevel none

Where [Product names] is a comma delimited list of product names.

5. Delete the copy of SMART Uninstaller in the temporary location by running the following
command:

del "%TEMP%"\SMART Uninstaller.exe"
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To remove select SMART software by product code

1. Copy SMART Uninstaller to a temporary location by running one of the following commands:

o For 32-bit operating systems:

copy "%CommonProgramFiles%\SMART Technologies\

SMART Uninstaller.exe" "%TEMP%"

o For 64-bit operating systems:

copy "%CommonProgramFiles(x86)%\SMART Technologies\

SMART Uninstaller.exe" "%TEMP%"

2. Remove select software by running the following command:

start /wait "SMART Uninstaller" "%TEMP%\SMART Uninstaller.exe"

--noui --uninstall-pc [Product codes] --uilevel none

Where [Product codes] is a comma delimited list of product codes (seeProduct codes on the
next page).

4. Delete the copy of SMART Uninstaller in the temporary location by running the following
command:

del "%TEMP%"\SMART Uninstaller.exe"

Other commands
In addition to the commands in the recommended procedures, you can include the following
commands with SMART Uninstaller.

Command Description Notes (if any)

--dry-run Runs the command line but
doesn’t remove the
software.

This is useful for testing
command lines before
implementing them.

--locale [Language code]

Where [Language code] is a language
code (for example, fr for French)

Displays SMART
Uninstaller in a language
other than the operating
system’s language.

The appropriate language
pack must be installed to
display SMART Uninstaller
in the language.

--uilevel [Level]

Where [Level] is none, basic (default),
reduced or full

Specifies the user interface
that displays when SMART
Uninstaller removes the
software.

Normally, --uilevel none
is used only in combination
with --noui.
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Command Description Notes (if any)

--no-auto-remove Disables the automatic
removal of supporting
packages (for example,
SMART Common Files) that
are no longer required after
the selected packages are
removed.

This is used only if --noui
is also included.

--noui Doesn’t display the SMART
Uninstaller user interface.

Normally, --noui is used
only in combination with
--uilevel none.

--uninstall-all Removes all detected
SMART packages.

--uninstall [Product names]

Where [Product names] is a comma
delimited list of product names

Removes the specified
products.

--uninstall-pc
[Product codes]

Where [Product codes] is a comma
delimited list of product codes (see
Product codes below)

Removes the specified
products.

Product codes

SMART Meeting Pro software

Version Product code

2.0 {596BD3B5-DC48-4AD2-A60A-4C39C9852294}

2.1 {4BD7F008-CDD9-454D-8A5B-4FF8BB8FEF02}

2.2 {76F84A17-835E-46C7-9C31-520BAFD5AC9D}

2.3 {E1660294-4C1E-4893-A40D-FFE0051E824F}

3.0 {C75C357C-3368-4142-AC8D-9F528B57373D}

3.1 {0F31DCED-1093-44C8-B606-70C5F108E70B}

3.1 SP1 {A6C3D76B-3CDB-4A35-82B3-E66B9B518152}

4.0 {3AA433E4-4280-4E84-A276-225313E9658C}
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Remote Ink service

Version Product code

1.0 {7B388E17-638C-4DCF-986E-F68D33974130}

Remote Ink client

Version Product code

1.0 {B6FCC721-9A73-46EA-88C6-7FC2F5138F24}

SMART Product Drivers

Version Product code

10.0.124.0 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}

10.0.131.0 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}

10.0.163.1 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}

10.0.165.1 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}

10.0.186.2 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}

10.0.188.3 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}

10.0.232.4 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}

10.0.255.5 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}

10.0.314.5 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}

10.0.392.6 {00C68967-9790-40DA-86F7-FDB248A5CDB1}

10.0.528.7 {AA9C1126-50DD-4993-9CDC-0BED8167293C}

10.0.532.7 {984EAE92-6043-451A-B786-9327FF165310}

10.6.48.0 {2623A1E3-478A-4F4A-A522-3A3D784A0C9C}

10.6.106.1 {487F1117-8BDE-4518-A798-015172AE0410}

10.6.175.2 {333B0B76-FC96-4C51-9AF6-B6EFA15ACE99}

10.7.81.0 {1355416A-967D-47C5-823D-D493C3E0B97C}

10.7 SP1 {4CE6C6E8-0DAD-4757-86ED-7FB4035BA98B}

10.8 {67E6410C-1E97-4D03-BEC2-8E83323A6BBD}

11.0 {E3189F44-F7BD-4F96-B756-A0AEFAF61D3A}

11.1 {E91FBB79-D736-4834-A1AB-2A5CDD2DB7E7}

11.2 {22A358FC-AF39-423A-9B2A-6F52B56615C3}
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SMART Ink

Version Product code

1.0 {4A1F2472-6164-43FA-9D2F-B35E71A8DF32}

1.1 {4A1F2472-6164-43FA-9D2F-B35E71A8DF32}

1.1 SP1 {F0E390A2-AB03-4077-83C4-F12D3A65493D}

1.5 {4B29EB9E-8205-4919-B069-22B531429FFE}

SMART Common Files

Version Product code

2011 (10.8) {0E5DD7A3-BE29-430C-970B-C553F4A58C39}

2012 (11.0) {ED2455F7-6AA6-4D3C-85E9-A72297DD7051}

2013 (11.1) {3D7235B2-3305-4FE1-A9A1-5F8AC2F33122}

2013 (11.2) {9057211D-439A-4C0D-95DE-498CF54ADF8C}
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Properties

SMART Meeting Pro installation package
The following are properties for the SMART Meeting Pro installation package:

Property Allowed values Notes

General properties

TRANSFORMS [String]: A languageMST file for the
installation (see Installation language files and
codes on page 49).

Ensure the specifiedMST file is in the same
folder as theMSI file.
This property defines the language of the
installer’s user interface and the installed
software’s iconsand shortcuts. It doesn’t
define the installed software’s user interface
language. The installed software uses the
computer’s operating system language if it’s
supported, or English (U.S.) if not.
You can also use the TRANSFORMS
property to apply anMST file created by
SMART Install Manager (seeUsing
SMART Install Manager on page 5) or a
third-party tool.

INSTALLDIR [String]: The path to your preferred folder for
SMART Meeting Pro software.
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Property Allowed values Notes

ENABLE_MP_
CONNECTOR_LYNC

0 (default): Disable remote collaboration.
1: Enable Bridgit integration for
SMART Meeting Pro software remote
collaboration.
2: Enable Lync integration for
SMART Meeting Pro software remote
collaboration.

You’re unable to change the collaboration
option after installation.
For information on installing and configuring
SMART Meeting Pro connector for Lync,
see Installing and configuring SMART
Meeting Pro connector for Lync on page 53.

ISX_
SERIALNUM

[String]: A 25-character SMART Meeting Pro
product key.

LYNC_SERIALNUM [String]: A 25-character SMART Meeting Pro
connector for Lyncproduct key.

ACTIVATE_
LICENSE

1 (default): Register the product keyand
automatically activate the software.
[Empty string]: Register the product keybut
don’t automatically activate the software.

Youmust include the
ISX_SERIALNUMproperty for this property
to work.
For massactivation information, see page
21.

SMART Meeting Pro software properties

BRIDGIT_
SERVER_NAME

[String]: The name of the Bridgit server (for
example, bridgit.example.com).

The Bridgit server enables the
SMART Meeting Pro software installation to
connect to other SMART Meeting Pro
software installations. For more
information, see smarttech.com/bridgit.
If no server name is provided, Bridgit
software integration is disabled.

SERVER_PWD [String]: The accesspassword for the Bridgit
server.

CREATION_PWD [String]: The creation password for the Bridgit
server.

ENABLEBRIDGIT
AUTOSHARE

1: Share themain screen each time a user
starts a new session.
0 (default): Don’t share themain screen each
time a user starts a new session.

ENABLEBRIDGIT
SHOWPASSWORD

1 (default): Show themeeting password in
text on the Bridgit Collaboration Bar.
0: Mask themeeting password on the Bridgit
collaboration bar.

ADMIN_PWD [String]: A password that usersmust enter to
modify the SMART Meeting Pro software
settings.

If you don’t specify a value, no password will
be required to change SMART Meeting Pro
software settings.

EMAIL_ADDRESS [String]: Type the sender e-mail address for
the SMART Meeting Pro software installation.

Users can e-mailWhiteboard files to
themselvesor to other users in
SMART Meeting Pro software. The
software uses this e-mail address in the
Sender field.

http://www.smarttech.com/bridgit


A P P E N D I X A

Windows Installer properties and parameters

43 smarttech.com/kb/170518

Property Allowed values Notes

EMAIL_SERVER [String]: An e-mail server for the
SMART Meeting Pro software installation (for
example,mail.example.com).

Users can e-mailWhiteboard files to
themselvesor to other users in
SMART Meeting Pro software. The
software uses this e-mail server to send the
file.

USE_SYSTEM_EMAIL 0 (default): Don’t use the computer’s default
e-mail client to send e-mailmessages.
1: Use the computer’s default e-mail client to
send e-mailmessages.

The default e-mail client must be properly
configured for e-mail to be sent.

USE_CALLIGRAPHIC_
INK

1 (default): Use calligraphic ink, which
smoothes your writing strokesand improves
the readability of your notes.
0: Use regular ink.

CREATE_
DESKTOPICONS

1 (default): Include a shortcut to the software
on the desktop.
[Empty string]: Don’t include a shortcut to the
software on the desktop.

LOSU_
MEETINGPRO

1 (default): Start SMART Meeting Pro
software when the user logson.
0: Don’t start SMART Meeting Pro software
when the user logson.

ENABLE_EXCHANGE 1 (default): EnableMicrosoft Exchange
integration.
0: Don’t enableMicrosoft Exchange
integration.

Youmust also add the room resource’s
unique e-mail addressafter installation (see
Adding a unique e-mail address to each
computer after installation on page 22).

EXCHANGE_RM_EMAIL [String]: A room resource e-mail address to
linkwith Microsoft Exchange.

Each computer requiresa unique room
resource e-mail address.

EX_AUTO_START 1 (default): Automatically start scheduled
meeting at logon.
0: User must manually start scheduled
meeting after logon.

EX_AUTO_BOOK 1 (default): Automatically bookan
unscheduledmeeting at logon.
0: User must manually bookan unscheduled
meeting after logon.

If you select 1, an unscheduledmeeting
starts automatically at logon if the room
resource is available for the next 30
minutes.

EX_AUTO_RESET 1 (default): Automatically reset room after
meeting end time.
0: Disable automatic room reset.

EX_RESET_DELAY 5 (default): Delay time inminutesbefore
automatic room reset feature activates.

Type the preferred delay time inminutes.
Only delay valuesof 1, 5 or 10minutesare
supported.

EX_AUTO_AGENDA 1 (default): Automatically insert agenda after
meeting starts.
0: Disable automatic insertion of agenda.

The agenda includesanymeeting details
the user typed in themeeting invitation in
Outlook.



A P P E N D I X A

Windows Installer properties and parameters

44 smarttech.com/kb/170518

Property Allowed values Notes

GALLERYDIR [CommonAppDataFolder]\SMART
Technologies\Gallery\MyContent

The path to the Added Content folder,
which is on the local computer where
user-created content is stored.

EXTOLLER [String]: Specify the path to add additional
Gallery content folders.

This property is optional.

UNBOUNDWHITEBOARD 1 (default): SMART Meeting Pro software
presents pages in unboundWhiteboard style.
0: SMART Meeting Pro software presents
pages in classicWhiteboard style.

In unboundWhiteboard style, pageshave
no defined boundaries, and the page area
can be significantly larger than the viewable
area. This is beneficialwhen userswant to
useWhiteboardmode for brainstorming or
to zoom in on specific details in large,
detailedmaps, diagramsor other images.
In classicWhiteboard style, pageshave
defined boundaries, and the page area is
usually the same asor slightly larger than
the viewable area. This is beneficialwhen
userswant to present content to others in
Whiteboardmode and want all content to be
visible at the same time in the viewable area.
SMART recommends that you select
unboundWhiteboard style.

DEFAULT_MEETING_
MODE

4 (default): SMART Meeting Pro software
starts inWhiteboardmode.
1: SMART Meeting Pro software starts in
Desktopmode.

DEFAULT_FILE_
FORMAT

3 (default): Save files in .fcw format.
1: Save files in .pdf format.
2: Save files in .ppt or .pptx format.
0: Save files in .notebook format.

If you select the unboundWhiteboard style,
do not select .notebookas the default file
format. Users are unable to save unbound
Whiteboard files to .notebook format.
Files saved in .pdf format can’t be opened
again in SMART Meeting Pro software.
Files saved in .ppt or .pptx format can be
opened in SMART Meeting Pro software
but have reduced functionality.
Users are still able to select a different file
format when they save whiteboard pages.
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SMART Product Drivers installation package
The following are properties for the SMART Product Drivers installation package:

Property Allowed values Notes

General properties

TRANSFORMS [String]: A languageMST file for the installation
(see Installation language files and codes on
page 49).

Ensure the specifiedMST file is in the same
folder as theMSI file.
This property defines the language of the
installer’s user interface and the installed
software’s iconsand shortcuts. It doesn’t define
the installed software’s user interface language.
The installed software uses the computer’s
operating system language if it’s supported, or
English (U.S.) if not.
You can also use the TRANSFORMSproperty
to apply anMST file created by
SMART Install Manager (seeUsing
SMART Install Manager on page 5) or a
third-party tool.

INSTALLDIR [String]: The path to your preferred folder for
SMART Product Drivers.

If you don’t specify a folder,Windows Installer
installsSMART Product Drivers in
[Program files (x86) folder]\
SMART Technologies\
SMART Product Drivers.

SPU properties

INSTALL_SPU 1 (default): Install SPU in Fullmode.
2: Install SPU in Dashboardmode.
0: Don’t install SPU.

In Fullmode, users can view the installed
versionsof SMART software aswell as their
product keys, and download and install
updates.
In Dashboardmode, users can view only the
installed versionsof SMART software and their
product keys.

SPU_TIME_
FRAME

[Integer]: The time in days (1 to 60) between
SPU checks.

Bydefault, SPU checks for product updates
every 30 days.
This property is applicable only if you install
SPU.

PRODUCT_
NOTIFICATION

1 (default): Notify the user when updatesare
available from SPU.
0: Don’t notify the user when updatesare
available from SPU.

This property is applicable only if you install
SPU.

Customer Experience Program properties

CUSTOMER_
LOGGING

0 (default): Disable the Customer Experience
Program.
1: Allow the user to enable or disable the
Customer Experience Program.
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Property Allowed values Notes

SMART Product Drivers properties

ENABLE_
STPCS

1 (default): Use Tablet PC functionalitywith the
SMART interactive product without connecting
a Tablet PC.
[Empty string]: Don’t use Tablet PC functionality
with the SMART interactive product without
connecting a Tablet PC.

Enabling Tablet PC support is applicable to
Windows7 operating system only. It hasno
effect on other operating systems.
If you specify [Null], users don’t have touch
support at theWindows logon screen.

LOSU_BRDTOOLS 1 (default): Display the SMART Board icon in
the notification area when the computer starts.
[Empty string]: Don’t display the SMART Board
icon in the notification area when the computer
starts.

LOSU_INK 1 (default): Start SMART Inkwhen the user
logson.
[Empty string]: Don’t start SMART Inkwhen the
user logson.

DEFAULT_PDF 1 (default): Set SMART InkViewer as the
default PDF viewer.
[Empty string]: Don’t set SMART InkViewer as
the default PDF viewer.

START_SNMP_
SERVICE

1: Start the SNMPagent.
0 (default): Don’t start the SNMPagent.

INSTALL_
UNSIGNED_
DRIVERS

1: Enable the registration of unsigned
third-party drivers.
0 (default): Disable the registration of unsigned
third-party drivers.

If you enable the registration of unsigned
third-party drivers, the installation process could
askusers if they trust themakers of the drivers
during installation. This can cause issues if you
deploy the installation in Silent mode.
Therefore, it’s best to disable the registration of
third-party drivers if you deploy the installation in
Silent mode.

Language pack properties

CS 1: Install the Czech language pack.

DA 1: Install the Danish language pack.

NL 1: Install the Dutch language pack.

EN_GB 1: Install the English (UK) language pack.

FI 1: Install the Finnish language pack.

FR 1: Install the French language pack.

DE 1: Install the German language pack.

IT 1: Install the Italian language pack.

NB 1: Install the Norwegian language pack.

ES 1: Install the Spanish language pack.

SV 1: Install the Swedish language pack.
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Parameters
The following are the standardWindows Installer parameters for themsiexec command.

Parameter Use

/q Hide the installation wizard.

N OTE

This is Silent mode.

/qb Show a basic installation wizard.

/qb! Show a basic installation wizard without aCancel button.

/qb+ Show a basic installation wizard with a dialog box signaling the end of the
installation.

/qb+! Show a basic installation wizard without aCancel button but with a dialog box
signaling the end of the installation.

/qr Show a reduced installation wizard.

/qf Show the full installation wizard, including a dialog box signaling the end of the
installation or the Fatal Error, User Exit orExit dialog box.

/qn Hide the installation wizard and the dialog box signaling the end of the
installation.

/qn+ Hide the installation wizard but show the dialog box signaling the end of the
installation.





Appendix B

49 smarttech.com/kb/170518

Appendix B: Language files and codes
Installation language files and codes 49
Language packs 50

Installation language files and codes
Language Code File

Czech 1029 1029.mst

Danish 1030 1030.mst

Dutch 1043 1043.mst

English (U.S.) 1033 1033.mst

English (UK) 2057 2057.mst

Finnish 1035 1035.mst

French 1036 1036.mst

German 1031 1031.mst

Italian 1040 1040.mst

Norwegian 1044 1044.mst

Spanish 1034 1034.mst

Swedish 1053 1053.mst
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Language packs
File Code

czech_language_pack.msi {31510F9E-524D-417E-B444-5F451F326F1A}

danish_language_pack.msi {4AE16993-EAFC-477A-A8B4-767009D04839}

dutch_language_pack.msi {3179A8F1-BE7B-498E-9C64-A7215077B7CB}

english_(united_kingdom)_language_
pack.msi

{C382B61B-9E03-41C4-9FE8-622AC4F5D6D9}

finnish_language_pack.msi {59A1167F-5E0F-4A43-A0BC-D5263947A22A}

french_language_pack.msi {BD68F04C-A5F0-440E-A7DE-EF002E9EB232}

german_language_pack.msi {AE377392-03BF-4DF9-B619-BA6413B858B6}

italian_language_pack.msi {D19B576F-F1ED-4A8C-8C56-F3362349F82E}

norwegian_language_pack.msi {9B492431-A6EE-4BBF-B6EF-D0C915106639}

spanish_language_pack.msi {6C135A2D-AF33-44BB-A08A-13B81425F54F}

swedish_language_pack.msi {541EED4D-6E96-4B5D-B030-603029CC5883}
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Appendix C: Microsoft Exchange Server
polling intervals
A user can start a scheduledmeeting or an unscheduled ad hoc meeting when he or she logs into a
room resource computer. Depending on the availability of the room resource, meetings can be started
automatically or manually. To enable this, SMART Meeting Pro software polls theMicrosoft
Exchange Server that it’s integrated with to retrieve the logged in user’s calendar and the times that a
room is booked.

SMART Meeting Pro software polls theMicrosoft Exchange server at the following intervals:

l When SMART Meeting Pro software starts.

l Every 10 seconds for the first fiveminutes after the start of a meeting (to enablemeeting rooms
to automatically join a Bridgit meeting).

l Once every minute after the first fiveminutes of ameeting (to ensure that a user can extend a
meeting only if the room is available beyond the scheduledmeeting).

l When a different user logs into the room resource computer with his or her network credentials.

T I P

See the SMART Meeting Pro software online Help for more details on extending ameeting and
adding other meeting rooms to a scheduledmeeting.

N OTE

SMART Meeting Pro software polls theMicrosoft Exchange Server only for the time stamp that
records the last time a user or room calendar was changed. If the time stamp received from the
server is later than the time stamp saved by SMART Meeting Pro software, then
SMART Meeting Pro software will access the room or user calendar (or both). By using this polling
rate, SMART Meeting Pro software significantly reduces the load on theMicrosoft Exchange
Server.
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This appendix explains how to install and configure SMARTMeeting Pro connector for Lync, Remote
Ink client and Remote Ink service. Refer to this appendix if you’re organization is using Lync as its
collaboration option.

Installation overview
SMARTMeeting Pro connector for Lync consists of multiple components, which are installed on
different computers on your network.

Component Purpose Typical location

SMART Meeting Pro
software with SMART
Meeting Pro connector for
Lync enabled and Remote
Ink client

Enables remote and local teams
to collaborate in real time using
SMART Meeting Pro software in
conjunction Lync 2010 software.

Meeting room computer

Remote Ink client Enables remote participants who
don’t have SMART Meeting Pro
software installed on their
computer to collaborate with
other meeting participants who
use SMART Meeting Pro
software with SMARTMeeting
Pro connector for Lync enabled.

Remotemeeting participant’s
laptop or desktop computer

Remote Ink service Enables the room computer of
themeeting participant who’s
sharing his or her desktop to
receive digital ink data from
Remote Ink clients.

Computer with a network
connection to computers hosting
Remote Ink client software
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To install SMART Meeting Pro software with SMART Meeting Pro connector for Lync
enabled and Remote Ink client

I M POR TA N T

Youmust deploy and configure Lync client software on the computer that will host
SMART Meeting Pro software with the SMARTMeeting Pro connector for Lync enabled before you
deploy SMART Meeting Pro software.

The Lync client must be Lync 2010 full client (as opposed to Lync 2010 Attendee or Lync Web App)
with a connection to a Lync Server 2010 application.

1. Ensure your computers meet theminimum software and hardware requirements (seeComputer
requirements on the next page).

2. Download the SMART Product Drivers and SMART Meeting Pro software installation
packages. For more information on the required installation packages (including third-party
installation packages), see Installation packages and supporting files on page 57.

3. Customize the installation packages, including selecting the SMARTMeeting Pro connector for
Lync collaboration option (seeUsing SMART Install Manager on page 6 andUsing third-party
tools on page 13).

4. Download Remote Ink client installation packages. For more information on the required
installation packages (including third--party installation packages), see Installation packages and
supporting files on page 57.

5. Deploy the installation packages (seeDeploying SMARTMeeting Pro connector for Lync on
page 62).

6. Configure SMART Meeting Pro software after deployment if required (seeConfiguring
SMART Meeting Pro software on page 21).

7. Configure Remote Ink client (seeConfiguring Remote Ink software on page 65).

To install Remote Ink client

I M POR TA N T

Youmust deploy and configure Lync client software on the computer that will host Remote Ink
client, before you deploy Remote Ink client.

The Lync client must be Lync 2010 full client (as opposed to Lync 2010 Attendee or Lync Web App)
with a connection to a Lync Server 2010 application.
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1. Ensure your computers meet theminimum software and hardware requirements (seeComputer
requirements on page 59).

2. Download the Remote Ink client installation packages. For more information on the required
installation packages (including third--party installation packages), see Installation package and
supporting file on page 59.

3. Deploy the installation packages (seeDeploying Remote Ink client software on page 63).

4. Configure Remote Ink client (seeConfiguring Remote Ink software on page 65).

To install Remote Ink service

1. Ensure your computers meet theminimum software and hardware requirements (seeComputer
requirements on page 60).

2. Download and deploy the Remote Ink service installation packages. For more information on the
required installation packages (including third--party installation packages), see Installation
package and supporting file on page 61.

3. Deploy the Remote Ink service installation packages (seeDeploying Remote Ink service on
page 63).

4. Configure and start Remote Ink service (seeConfiguring Remote Ink software on page 65).

I M P OR TA N T

Configure Remote Ink service before you start the service.

Before installing SMARTMeeting Pro connector
for Lync
Before you install SMART Meeting Pro software with SMARTMeeting Pro connector for Lync
collaboration option enabled, ensure your computers meet theminimum requirements defined in this
section. This section also provides information on the installation packages and supporting files
required for this installation option.

Computer requirements

I M P OR TA N T

SMARTMeeting Pro connector for Lync software supports systems that have amaximum of four
displays.
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l Windows 7 orWindows 8 operating systems

T I P

Formoreminimum hardware requirements, see the Lync 2010 and theOnlineMeeting Add-in
for Microsoft Lync 2010 System Requirements web page.

l Microsoft Lync 2010 full client (not Lync 2010 Attendee or Lync Web App)

l Internet Explorer® 6 or later

l SMART Meeting Pro software integration with Microsoft Exchange enabled (to use the
scheduledmeeting integration feature in SMART Meeting Pro software)

l 10Mbps (minimum) wired network connection (1 Gbps wired network connection recommended)

l A computer connecting to Remote Ink service softwaremust meet the following requirements:

o Be authenticated on a trusted domain

o Have valid domain credentials

o Connect from a trusted domain/forest

N OTE S

l Youmust enable SMART Meeting Pro software integration with Microsoft Exchange to use
the scheduledmeeting integration feature in SMART Meeting Pro software.

l Users must be authenticated on a trusted domain with access to a computer hosting Remote
Ink service.

Installation packages and supporting files
The following installation packages (also known as MSI files) and supporting files are required to
install and configure SMARTMeeting Pro connector for Lync.

Save the packages in a location on your network that’s accessible to all computers on which you plan
to install the software.

The following third-party installation packages are contained in the SMART Meeting Pro software .zip
file available from smarttech.com/administratordownloads. The installation packages are located in
folders in the .zip file.

T I P

You can also download these third-party installation packages frommicrosoft.com/downloads.

http://technet.microsoft.com/en-us/library/gg412781.aspx
http://www.smarttech.com/administratordownloads
http://www.microsoft.com/downloads
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Installation package File name

Microsoft .NET Framework 4
(Standalone Installer)

dotNetFx40_Full_x86_x64.exe

Microsoft Visual Studio Tools for Office
for 32-bit computers

vstor40_x86.exe

Microsoft Visual Studio Tools for Office
for 64-bit computers

vstor40_x64.exe

N OTE

You can run the dotNetFx40_Full_x86_x64.exe file to install all requiredMicrosoft .NET
Framework prerequisites and theMicrosoft .NET Framework 4 Full files. However, SMART
recommends that you download the latest version of theMicrosoft .NET Framework files from the
Microsoft website. For information on deploying theMicrosoft .NET Framework, refer to the .NET
Framework Deployment Guide for Administrators on theMSDN website
(msdn.microsoft.com/en-us/library/ee390831.aspx).

Download the .zip files containing the SMART installation packages from
smarttech.com/administratordownloads.

N OTE

The Remote Ink.zip file includes the Lync 2010 SDK runtime installation program
(LyncSdkRedist.msi).

Installation package File name

SMART Product Drivers SMART Product Drivers Installer.msi

SMART Meeting Pro software SMART Meeting Pro.msi

Remote Ink client SMART Remote Ink.msi

Before installing Remote Ink client
Before you install Remote Ink client software, ensure your computers meet theminimum
requirements defined in this section. This section also provides information on the installation
packages and supporting files required for this installation option.

http://msdn.microsoft.com/en-us/library/ee390831.aspx
http://www.smarttech.com/administratordownloads
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Computer requirements
l Windows 7 orWindows 8 operating systems (see the Lync 2010 and theOnlineMeeting Add-in

for Microsoft Lync 2010 System Requirements web page for minimum hardware requirements)

l 10MB of free hard disk space

l 1024 × 768 screen resolution (or higher)

l Microsoft Lync 2010 (full client as opposed to Lync 2010 Attendee or Lync Web App)

l Remote Ink client software and Lync SDK redistributable installed

l Microsoft .NET Framework 4 Full (not Client)

l VPN access to Remote Ink service or connection through a secureWAN if connecting to
Remote Ink service from outside of a corporate network

N OTE

Users must be authenticated on a trusted domain with access to the computer hosting Remote Ink
service.

Installation package and supporting file
The following installation package (also known as anMSI file) and supporting file are required to
install and configure Remote Ink client software.

Save the package in a location on your network that’s accessible to the computer on which you plan
to install the software.

The following third-party installation package is contained in the Remote Ink .zip file available from
smarttech.com/administratordownloads. The installation package is located in a folder in the .zip file.

T I P

You can also download this third-party installation package frommicrosoft.com/downloads.

Installation package File name

Microsoft .NET Framework 4
(Standalone Installer)

dotNetFx40_Full_x86_x64.exe

http://technet.microsoft.com/en-us/library/gg412781.aspx
http://www.smarttech.com/administratordownloads
http://www.microsoft.com/downloads
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N OTE

You can run the dotNetFx40_Full_x86_x64.exe file to install all requiredMicrosoft .NET
Framework prerequisites and theMicrosoft .NET Framework 4 Full files. However, SMART
recommends that you download the latest version of theMicrosoft .NET Framework files from the
Microsoft website. For information on deploying theMicrosoft .NET Framework, refer to the .NET
Framework Deployment Guide for Administrators on theMSDN website
(msdn.microsoft.com/en-us/library/ee390831.aspx).

Download the .zip file containing the SMART installation package from
smarttech.com/administratordownloads.

N OTE

The Remote Ink .zip file includes the Lync 2010 SDK runtime installation program
(LyncSdkRedist.msi).

Installation package File name

Remote Ink client SMART Remote Ink.msi

Before installing Remote Ink service
Before you install Remote Ink service, ensure your computers meet theminimum requirements
defined in this section. This section also provides information on the installation packages and
supporting files required for this installation option.

Computer requirements

I M P OR TA N T

Remote Ink service software is not configured for use on untrusted networks such as the Internet.

l Windows Server® 2008 R2 SP1 (see the InstallingWindows Server 2008 R2web page for
minimum hardware requirements)

l 2GB of RAM

l 10GB of free hard disk space

l Microsoft .NET Framework 4 Full (not Client)

http://msdn.microsoft.com/en-us/library/ee390831.aspx
http://www.smarttech.com/administratordownloads
http://technet.microsoft.com/en-us/library/dd379511(v=ws.10).aspx
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l 10Mbps wired network connection (1 Gbps wired network is recommended)

l Remote Ink service software at a central site on a dedicated physical or virtual server

Installation package and supporting file
The following installation package (also known as anMSI file) and supporting file are required to
install and configure Remote Ink service software.

Save the package in a location on your network that’s accessible to the computer on which you plan
to install the software.

The following third-party installation package is contained in the Remote Ink .zip file available from
smarttech.com/administratordownloads. The installation package is located in a folder in the .zip file.

T I P

You can also download this third-party installation package frommicrosoft.com/downloads.

Installation package File name

Microsoft .NET framework 4 (Standalone
Installer)

dotNetFx40_Full_x86_x64.exe

N OTE

You can run the dotNetFx40_Full_x86_x64.exe file to install all requiredMicrosoft .NET
Framework prerequisites and theMicrosoft .NET framework 4 Full files. However, SMART
recommends that you download the latest version of theMicrosoft .NET Framework files from the
Microsoft website. For information on deploying theMicrosoft .NET Framework, refer to the .NET
Framework Deployment Guide for Administrators on theMSDN website
(msdn.microsoft.com/en-us/library/ee390831.aspx).

Download the .zip file containing the SMART installation package from
smarttech.com/administratordownloads.

Installation package File name

Remote Ink service Remote Ink Service.msi

http://www.smarttech.com/administratordownloads
http://www.microsoft.com/downloads
http://msdn.microsoft.com/en-us/library/ee390831.aspx
http://www.smarttech.com/administratordownloads
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Deploying installation packages
You can deploy installation packages using the command line interface.

OR

You can deploy installation packages using third-party imaging or remotemanagement software.

N OTE

As an alternative to deploying the installation packages as documented in this guide, you can install
the software by downloading and using the installation wizard.

Deploying SMARTMeeting Pro connector for Lync

I M P OR TA N T

l Lync client softwaremust be installed and configured on the computer that will host
SMART Meeting Pro software with the SMARTMeeting Pro connector for Lync enabled,
before you install SMART Meeting Pro software.

l If you install Lync client software after installing SMART Meeting Pro software, youmust
restart SMART Meeting Pro software to enable SMARTMeeting Pro connector for Lync
integration.

l The Lync client must be Lync 2010 full client (as opposed to Lync 2010 Attendee or Lync Web
App) with a connection to a Lync Server 2010 application.

l SMART Meeting Pro softwaremust be installed before Remote Ink client software.

After you download the installation packages (see Installation packages and supporting files on page
57) and customize them (seeCustomizing installation packages on page 5), deploy them in the
following order:

Order Installation package Instructions

1 Microsoft .NET Framework 4 Extended
Profile and Client Profile (if not installed)

SeeDeploying the software on page 15.

2 Microsoft Visual Studio Tools for Office (if
not installed)

SeeDeploying the software on page 15.

3 SMART Product Drivers SeeDeploying the software on page 15.

4 Lync 2010 SDK (Lync SDK redistributable) Seemsdn.microsoft.com/
en-us/library/hh378534.aspx).

5 SMART Meeting Pro SeeDeploying the software on page 15.

http://msdn.microsoft.com/en-us/library/hh378534.aspx
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Order Installation package Instructions

6 Remote Ink client SeeDeploying the software on page 15 and
page 63.

Deploying Remote Ink client software
After you download the installation packages (see Installation package and supporting file on page
59), deploy them in the following order:

Order Installation package Instructions

1 Microsoft .NET 4 Full Profile (if not
installed)

SeeDeploying the software on page 15.

2 Lync 2010 SDK (Lync SDK redistributable) Seemsdn.microsoft.com/
en-us/library/hh378534.aspx).

3 Remote Ink client SeeDeploying the software on page 15 and
page 63.

To install Remote Ink client using the command line interface

Run the following command if there is no previous installation of Remote Ink client on your
computer:

msiexec /i "[Path]\SMART Remote Ink.msi"

OR

Run the following command if there is a previous installation of Remote Ink client on your
computer:

msiexec /i "[Path]\SMART Meeting Pro.msi" REINSTALL=ALL

RINSTALLMODE=vomus

Where [Path] is the path to theSMART Meeting Pro.msi file.

For information on configuring Remote Ink client software to discover and connect to Remote
Ink service software, seeConfiguring Remote Ink software on page 65.

Deploying Remote Ink service

I M P OR TA N T

Youmust configure Remote Ink service before starting the service after deployment (see
Configuring Remote Ink software on page 65).

http://msdn.microsoft.com/en-us/library/hh378534.aspx
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After you download the installation packages (see Installation package and supporting file on page
61), deploy them in the following order:

Order Installation package Instructions

1 Microsoft .Net 4 Extended Profile (if not
installed)

SeeDeploying the software on page 15.

2 Remote Ink service SeeDeploying the software on page 15 and
page 64.

To install Remote Ink service using the command line interface

Run the following command:

msiexec /i "[Path]\Remote Ink Service.msi"

Where [Path] is the path to theRemote Ink Service.msi file.

Activating SMARTMeeting Pro connector for
Lync software after installation
There are two situations in which the software doesn’t activate completely:

l Imaging a computer: For the software to activate properly, each computer you install it on
must have a unique installation ID. If you use a computer image or clone a hard drive to set up
multiple computers, they all have the same installation ID as the original computer, which can
cause an activation error.

l Protecting software for computer configurations: If you use system recovery or protection
software, you should activate the software before you lock or freeze the computer for your users.
However, if you can’t, youmust activate the software afterward.

To activate SMART Meeting Pro connector for Lync software after installation

Run the following command:

"C:\Program Files\Common Files\SMART Technologies\

SMART Product Update\activationwizard.exe" --puid meeting_pro

--m=[Value] --v=3 --a [Optional flags] --pk [Product key]

Where [Product key] is the SMARTMeeting Pro connector for Lync product key.
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N OTE S

o You can addmultiple product keys by enteringmultiple instances of the product key
command line property (--pk [Product key]).

o You can also activate SMARTMeeting Pro connector for Lync through
SMART Product Update (SPU) by accessing the SMART Meeting Pro software entry in
the product list and adding the SMARTMeeting Pro connector for Lync product key.

Configuring Remote Ink software
This section provides information on configuring Remote Ink service and Remote Ink client after
deployment.

The following table identifies the required, recommended and optional Remote Ink software
configuration procedures.

Configuration procedure Required Recommended Optional

Configuring a base address and domain name system
(DNS) value for Remote Ink service (seeConfiguring
base address and DNS values for Remote Ink service on
the next page)

I M P OR TA N T

Youmust configure a base address and DNS value for
Remote Ink service before you start the service.

Configuring Remote Ink client to autodiscover Remote
Ink service using an SRV DNS resource record (see
Configuring autodiscovery of Remote Ink service on page
67)

Enabling Remote Ink client to connect to Remote Ink
service with user-specified and cached service
information (seeConfiguring user-specified and cached
service information on page 71)

Configuring how significant Remote Ink service program
events are logged (seeConfiguring event logs on page
74)

Configuringmeeting cleanup in Remote Ink service (see
Configuringmeeting cleanup on page 75)

Starting Remote Ink service after installation (see
Starting Remote Ink service on page 76)
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About Remote Ink service
Remote Ink service is aWindows Communication Foundation (WCF) service that enables meeting
participants using SMART Meeting Pro software with SMARTMeeting Pro connector for Lync
enabled to write and draw on shared desktop content. Remote Ink service runs as a self-hosted
Windows service.

N OTE S

l Remote Ink service requires the use of a duplex binding (NETTCP) to enable bidirectional
communication. For more information, see
msdn.microsoft.com/en-us/library/ms731343.aspx.

l By default, Remote Ink service uses a secure binding configuration that provides transport
encryption (TLS) usingWindows Credentials. Remote Ink service can also be configured to
use a certificate.

l Formore information about theWCF framework, see
msdn.microsoft.com/en-us/netframework/aa663324.aspx.

Configuring base address and DNS values for Remote Ink service
Use the following procedure to configure a base address and DNS value for Remote Ink service.

To configure the base address and DNS value

1. Go to [Program files (x86) folder]\SMART Technologies\Remote Ink Service.

2. OpenRemoteinkservice.exe.config with a text editor.

3. Scroll to and change the base address to the following:

<add baseAddress="net.tcp://[myhost.example.com]:35706/

RemoteInk"/>

Where

o [myhost.example.com] is the fully qualified domain name (FQDN) of the computer hosting
Remote Ink service software.

o The port number 35706 is configurable.

E X AMP LE

<add baseAddress="net.tcp://1.2.3.4:35706/RemoteInk"/>

http://msdn.microsoft.com/en-us/library/ms731343.aspx
http://msdn.microsoft.com/en-us/netframework/aa663324.aspx
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4. Scroll to and change the dns value to the following:

<dns value="[Domain name]"/>

Where [Domain name] is the domain name of the computer hosting Remote Ink service.

E X AMP LE

<dns value="example.inc"/>

5. Save the file.

Configuring howRemote Ink client connects to Remote Ink service
This section provides information on recommended procedures for configuring how Remote Ink client
connects to Remote Ink service.

I M P OR TA N T

If you do not complete the procedures in this section, users are prompted to enter the Remote Ink
service IP/Domain name each time they first log on to a computer hosting Remote Ink client
software (for example, the first time they use SMART Meeting Pro software with SMARTMeeting
Pro connector for Lync enabled in ameeting room or as a remote participant using Remote Ink
client).

The following procedures are given in this section:

l Configuring Remote Ink client software to autodiscover Remote Ink service

l Checking whether a computer can see an SRV record

l Configuring user-specified and cached service information

Configuring autodiscovery of Remote Ink service
This section explains how to configure Remote Ink client to autodiscover Remote Ink service using
an SRV DNS resource record.

You can enable Remote Ink client software to autodiscover Remote Ink service by creating the
appropriate SRV record on the network hosting Remote Ink service. Following installation, Remote
Ink client will attempt to discover Remote Ink service by looking up an SRV DNS resource record
that points to the Remote Ink service.
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I M P OR TA N T

l If an SRV record pointing to the Remote Ink service has not been created on the network
hosting Remote Ink service and roaming user profiles are not configured, then users are
prompted to enter the Remote Ink service IP/Domain namewhen they first log on to a
computer hosting Remote Ink client (for example, the first time they use Remote Ink client
software in that meeting room).

l If roaming user profiles are configured users are prompted only once to enter the Remote Ink
service IP/Domain namewhen they first log on to a computer hosting Remote Ink client and
are not prompted again.

To enable DNS autodiscovery, youmust add the SRV record to any domain from which a user can
connect to a hosting of Lync server software.

E X AMP LE

If a user logs on to a hosting of Lync server software with a user ID such as user1@example.com,
then the SRV recordmust be installed in the example.com domain. If another user can also log on
to the same Lync server software with a different user ID such as user2@anotherdomain.com,
then to enable this user to autodiscover the Remote Ink service, the SRV recordmust also be
added to the anotherdomain.com domain (or the user is prompted for the server information).

If all Lync server software users have IDs that each feature the same domain name, then the SRV
record need be installed only in the domain that the users share.

The following procedures can be used to create an SRV record:

l Manually configure the SRV record using the DNS server’s management interface

OR

l Use aWindows PowerShell® script provided under the Remote Ink service installation in the
Tools folder.

To manually configure the SRV record using the DNS server’s management interface

Create a record with the following values:

o Name: _smartremoteink

o Protocol: _tcp

o Priority: 0

o Weight: 0
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o Port: 35706

N OTE

This port number is configurable andmust match the number of the port chosen for
Remote Ink service.

o Host: Name of the computer hosting Remote Ink service, for example, ink.example.local

To use a PowerShell script provided under the software installation in the Tools folder

Run the following command to add an SRV record from using the command line interface:

powershell.exe -noexit [full path to]\ManageSrvRecord.ps1 -install

-nameserver [host name of name server] -zone [zone] -target

[host machine name] -ttl [time-to-live] -port 35706

Where

o [full path to] is the location of the Tools folder in the Remote Ink service installation.

E X AMP LE

C:\Program Files (x86)\SMART Technologies\Remote Ink Service\Tools

o [host name of name server] is the name of the DNS name server (i.e. the domain
controller).

o [zone] is the DNS zone in which the SRV record should be installed.

o [host machine name] is the name of the computer hosting Remote Ink service.

o [time-to-live] is the number of seconds a computer hosting Remote Ink client is
recommended to cache the DNS record in its local DNS cache.

N OTE

Use a value of 0 to avoid caching the DNS record. The default value for this parameter, if
not specified, is 86400 (i.e. 24 hours).

E X AMP LE

powershell.exe -noexit "C:\Program Files\SMART Technologies\

Remote Ink Service\Tools"\ManageSrvRecord.ps1

-install -nameserver dc1 -zone example.local -target

ink.example.local -ttl 86400 -port 35706
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N OTE

By default, theManageSrvRecord.ps1 uses a time to live (TTL) value of 86400 (24 hours). This
means that any DNS service that queries this SRV record caches the record for 24 hours. This
includes the DNS component that runs on every desktop computer. If you’re planning tomove
Remote Ink service to a different computer and are using a non-zero TTL for the SRV record, the
SRV recordmust be removed 48 hours before Remote Ink service is moved. The SRV recordmust
then be replaced by a record with a 0 TTL value as part of the command used to add an SRV record.
This procedure gives each Remote Ink client application time to clear its DNS cache. Alternatively,
if you use a TTL of 0 you don’t have to complete these actions.

If a new 0 TTL value isn’t used for the SRV record, computers hosting Remote Ink client that still
have the old invalid SRV record in cache don’t see the computer hosting Remote Ink service in its
new location (seeChecking whether a computer can see an SRV record below for information on
determining which SRV record a computer sees). A computer’s DNS cache can be cleared
manually using the ipconfig /flushdns command.

Checking whether a computer can see an SRV record
To check whether a computer can see an SRV record, use the nslookup command:

C:\> nslookup -type=SRV _smartremoteink._tcp.example.local

Optionally, on the computer where Remote Ink service is installed, use the following command:

powershell.exe -noexit “C:\Program Files\SMART Technologies\Remote Ink

Service\

Tools”\ManageSrvRecord.ps1 –query -nameserver dc1 -zone

example.local

Whenever Remote Ink client connects to Remote Ink service, an entry is made in the Remote Ink
software event log on the computer hosting Remote Ink client. This connection information could be
useful in troubleshooting issues.

For example, the following log entry shows that Remote Ink client discovered the Remote Ink service
by looking up its DNS SRV record:

E X AMP LE

Discovered service net.tcp://ink.example.local:35706/RemoteInk via SRV



A P P E N D I X D

Installing and configuring SMART Meeting Pro connector for Lync

71 smarttech.com/kb/170518

The following entry example shows that Remote Ink client previously connected to Remote Ink
service and cached the Remote Ink service information. Remote Ink service then used the cached
information to connect this time:

E X AMP LE

Discovered service net.tcp://ink.example.local:35706/RemoteInk in

Cache

Configuring user-specified and cached service information
If you are unable to use autodiscovery using DNS SRV records (for example, the DNS server cannot
be configured as described inConfiguring autodiscovery of Remote Ink service on page 67), then the
Remote Ink client software will prompt you for the host name and port number of the computer
hosting Remote Ink service. You won’t be prompted to enter the host name and port number again
unless this information changes (for example Remote Ink service is moved to a different computer).

I M P OR TA N T

The port numbermust consist of numeric characters only. Do not type in separator characters,
such as spaces, commas or periods.

Use the following procedures to add the IP/Domain name and port number of the computer hosting
Remote Ink service to Remote Ink client software’s RemoteInk.exe.config file. Adding these details
to the config file enables Remote Ink client software to connect to Remote Ink service without trying
to find the SRV record pointing to the Remote Ink service on the network.

Use the following procedure to configure the RemoteInk.exe.config file in a SMART Meeting Pro
software installation or a Remote Ink client installation.

To configure the RemoteInk.exe.config file in an installation

1. Go to the folder location appropriate to your operating system:

Operating
system

Location:

32-bit C:\Program Files\SMART Technologies\SMART Meeting Pro\
Remote Ink

64-bit C:\Program Files (x86)\SMART Technologies\SMART Meeting Pro\
Remote Ink

2. Copy theRemoteInk.exe.config file.
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3. Modify the contents of the copiedRemoteInk.exe.config file as follows:

o Change the value of theAutoDiscoverServiceEnabled key from true to false.

T I P

Changing the AutoDiscoverServiceEnabled key to false prevents Remote Ink client from
looking for an SRV record.

o Uncomment theServiceInfo key, and replace example.com:12345with the name of

the computer hosting Remote Ink service and its port number.

T I P

The default port number of the computer hosting Remote Ink service is 35706.

4. Replace the existingRemoteInk.exe.config file with themodifiedRemoteInk.exe.config file.

5. Go to%APPDATA%\SMART Technologies\RemoteInk\RemoteInkClientSettings.xml,and
then deleteRemoteInkClientSettings.xml (if it exists).

To configure the RemoteInk.exe.config file when only the client is installed

1. Go to the folder location appropriate to your operating system:

Operating
system

Location:

32-bit C:\Program Files\SMART Technologies\Remote Ink

64-bit C:\Program Files (x86)\SMART Technologies\Remote Ink

2. Copy theRemoteInk.exe.config file.
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3. Modify the contents of the copiedRemoteInk.exe.config file as follows:

o Change the value of theAutoDiscoverServiceEnabled key from true to false.

T I P

Changing the AutoDiscoverServiceEnabled key to false prevents Remote Ink client from
looking for an SRV record.

o Uncomment theServiceInfo key, and replace example.com:12345with the name of

the computer hosting Remote Ink service and its port number.

T I P

The default port number of the computer hosting Remote Ink service is 35706.

4. Replace the existingRemoteInk.exe.config file with themodifiedRemoteInk.exe.config file.

5. Go to%APPDATA%\SMART Technologies\RemoteInk\RemoteInkClientSettings.xml,and
then deleteRemoteInkClientSettings.xml (if it exists).

I M P OR TA N T

l If the network address of the computer hosting Remote Ink service software changes, then
you have to reconfigure theRemoteInk.exe.config file with the new address for the computer
hosting Remote Ink service.

l If youmigrate Remote Ink service to a new host computer, youmust uninstall the software
from its original host computer. This is because computers hosting Remote Ink client have
cached the network address of the original computer hosting Remote Ink service and will
continue to attempt to connect to this computer. However, some computers hosting Remote
Ink client will attempt to autodiscover and connect to the new computer hosting Remote Ink
service. Computers hosting Remote Ink client that are connected to different Remote Ink
service host computers are unable to interact with each other using Remote Ink service.

Configuring event logging andmeeting cleanup in Remote Ink service
This section provides information on the following optional Remote Ink service configuration
procedures.

l Configuring event logging

l Configuringmeeting cleanup
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Configuring event logs
This section contains information on configuring the way significant Remote Ink service program
events are logged. Use the procedures in this section to do the following:

l Configure which significant Remote Ink service program events are logged.

l Create a custom event source to redirect output from the default application log to a log
dedicated to Remote Ink service program events.

T I P

Redirecting output from the default application log is helpful if you’re troubleshooting Remote
Ink service and want a log containing only Remote Ink service program events.

To configure which program events are logged

1. Go to [Program files (x86) folder]\SMART Technologies\Remote Ink Service.

2. OpenRemoteinkservice.exe.config with a text editor.

3. Scroll to and change the comment for the following command:

<add key="LogLevel" value="[value]" />

Where [value] determines which events are logged.

Choose the events you want to log by entering a value from the table below.

Value Event level This value enables you to log the following event information:

0 Error Error

1 Warning Warning and Error

2 Informational Informational, Warning and Error

3 Debug Debug, Informational, Warning and Error
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To create a custom event source

1. Create a PowerShell script that contains the following commands andmodify the
customeventsource and logname variables to your custom values.

T I P

You can also execute the following commands directly in a PowerShell console.

$customeventsource = [My Custom Source]
$logname = [Application]
$creationData = new-object

System.Diagnostics.EventSourceCreationData $customeventsource,

$logname
[System.Diagnostics.EventLog]::CreateEventSource($creationData)

Where:

o [My Custom Source] is the new name of the customeventsource variable

o [Application] defines which event log is associated with theEventSource variable

2. Execute in a PowerShell console.

3. Go to [Program files (x86) folder]\SMART Technologies\Remote Ink Service.

4. OpenRemoteinkservice.exe.config with a text editor.

5. Change the default EventSource name to the name you gave to the customeventsource
variable, for exampleMy Custom Source.

Configuring meeting cleanup
You can configure Remote Ink service to use one of twomethods to clean upmeetings that have
expired and were not exited properly. When a collection is run, the service compares eachmeeting’s
last activity time with the configured user session timeout. If there has been no activity for a greater
amount of time than the session timeout, then themeeting is removed.

N OTE S

l Remote Ink client includes a keep-alive function, so program information frommeetings that
are in progress is never removed.

l By default the service is configured to use the scheduled time of 04:00 to clean upmeetings.

l If a scheduled collection interval is enabled this setting takes priority over using a scheduled
collection time. For example, if the service configuration has both the scheduled collection
time and an interval defined, the service uses the scheduled collection interval.
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Use the following procedure to configure Remote Ink service to capture program events at a set
interval.

To capture program events at a set interval

1. Go to [Program files (x86) folder]\SMART Technologies\Remote Ink Service.

2. OpenRemoteinkservice.exe.config with a text editor.

3. Scroll to and remove the comments from the following command:

<add key="ScheduledCollectionInterval" value="[01:00]"/>

Where [01:00] is the interval that collection is run.

N OTE

Removing the comments from this command enables Remote Ink service to clean up
meetings at a set interval rather than at a scheduled time each day.

Starting Remote Ink service
Use the following procedure to start Remote Ink service.

To start Remote Ink service

1. Go toC:\Windows\system32.

2. Double-click services.msc.

TheServices dialog box appears.

3. Scroll toRemote Ink Service, and then click the service.

4. On the actionmenu, click Start.

Remote Ink service starts.

T I P S

l If Remote Ink service doesn’t start, ensure the following:

o Microsoft.NET 4 Full (not Client) is installed on the computer hosting Remote Ink service.

o A firewall configuration isn’t blocking network traffic to and from the Remote Ink service.

l If you don’t see any logmessages, check that the event source has been created.
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